
Contents for FractalWeave Help
FractalWeave creates a practically infinite variety of beautiful and incredibly intricate 
screen images.
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What is FractalWeave? 
FractalWeave is an image generator which uses fractal-based patterns to construct 
scenes of astonishing complexity and beauty. By varying a small number of parameters, 
you can create a practically infinite variety of images.
FractalWeave allows you to save and restore the screens generated in standard Windows 
bitmap format. You can use these images in other Windows programs, or import images 
generated in other programs to FractalWeave. If your video system supports it, 
FractalWeave can perform color animation on images.
The "seed image", a so-called fractal ball, can be transferred directly to and from other 
programs via the Windows clipboard, saved as a Windows bitmap, or saved in a special 
parameter file which records program settings in addition to the graphics image. The 
parameter file can be reloaded in a later session of FractalWeave, or used by the 
FractalSave program to make a custom screen saver.
The easiest way to learn the program is to experiment with it. When the program starts, 
a random image is automatically generated. Press the <Enter> key or double-click with 
the mouse to bring up the New Ball Dialog Box. Press <Enter> again, or click the 
"Generate Random" button to close the dialog box and create a new (random) image.
When you have a feel for the types of images that might be created, try varying the 
parameters yourself. Look through the menus and see what options are available. Press 
F1 at any time to get on-line help.
Enjoy the program!
See Also
Creating a Fractal Ball
Using FractalWeave with Other Programs
Hardware Notes
Shareware Information



Repositioning the Fractal Ball 
Small changes in the initial position of the fractal ball can make an enormous difference 
in the colors and pattern generated. There are two ways to reposition the ball:
1. Position the mouse cursor at the desired starting point, then click the left mouse 
button while holding down the <Ctrl> key.
2. Bring up the New Ball Dialog Box and modify the Horizontal Offset and Vertical Offset 
values in the Initial Position group.
The first method allows you to quickly locate an interesting starting point, while the 
second method allows very precise control for fine tuning.
See Also
Keyboard/Mouse Commands



What is a Fractal? 
A fractal is a bizarre mathematical object possessing an infinitely detailed structure. 
Fractals do a better job of filling space than ordinary geometric objects, and have an 
effective dimension greater than their ordinary spatial dimension. The word itself comes 
from the Latin "fract(us)", meaning "broken" or "uneven".

The figure at left is a so-called "Sierpinski carpet", a type of fractal. Like many fractals, it 
is "self-similar", a mathematical way of saying that it looks the same at any 
magnification. (If you zoomed in on the tiniest square until it was the same size as the 
large central one, the image would look the same -- no matter how often you repeated 
the process.)    A Sierpinski carpet has a dimension of 1.8928; it does a better job of filling
space than a line, but because of the square holes at all levels, it doesn't quite fill a 
plane. In fact, the area of the carpet is zero, while the total perimeter of its holes is 
infinite.
FractalWeave uses a Sierpinski carpet deformed into the shape of a ball as the basic 
building block for its images.



The FractalSave Screen Saver 
FractalSave is a screen saver program which can display FractalWeave parameter files, or
any Windows bitmap when it is activated. FractalSave can display an unlimited variety of 
custom screen saver images ranging from the purely aesthetic (such as FractalWeave 
files) to the merely informational (such as simple text strings created with Windows 
Paintbrush).
As a preview, use the File | Open Ball or File | View Image commands to load any of the 
sample files included with FractalWeave. Select Options | Full Screen to enter full screen 
mode. The resulting display would be generated by FractalSave, as a screen saver 
image, if it were configured to use that file. FractalSave can also be configured to 
generate random FractalWeave images when it is activated, just as FractalWeave does 
when it starts each session.
FractalSave functions exactly like the screen savers supplied with Windows 3.1. You 
select and configure FractalSave from the Windows Control Panel, just as you do with the 
Windows screen savers. If you set a password in a Windows screen saver, FractalSave will
use it. If you modify the password in FractalSave, the Windows screen savers will know 
about and use the new password.
FractalSave is a shareware program written by the author of FractalWeave.
See Also
Using FractalWeave with Other Programs
Shareware Information



Shareware Information 
FractalWeave is a shareware program. You may copy and distribute it freely, and use it 
without charge for a period of 30 days. If you continue to use the program beyond the 
initial evaluation period, please register it.
Registration entitles you to technical support in the program's use, notice of and reduced
price for any upgrades, and that warm feeling of personal satisfaction that comes from 
doing the proper and noble thing.
As a registration bonus, the companion FractalSave Screen Saver program is included 
free with registration of FractalWeave. In addition, I'll send you a registration number that
prevents the occasional Shareware Reminder screen from being displayed, removes the 
Register command from the Help menu, and displays your name in the license 
information section of the About FractalWeave box. What more could you ask?
See Also
How to Register FractalWeave



Registering FractalWeave 
The registration fee for FractalWeave is $19.95 (US). As a registration bonus, the 
companion FractalSave Screen Saver program is included free with registration of 
FractalWeave. DOS versions of both programs are also available.
To register, send check or money order to:
James H. Price
1703 Santa Barbara St.
Santa Barbara, CA 93101
Please indicate how you would like your name to appear in the license information 
section of the About FractalWeave box.
Support
I can be reached by mail at the above address, or via CompuServe at 76264,3534. I 
would be pleased to receive any bug reports, comments, or suggestions for future 
versions. Thank you!
See Also
Entering Your Registration Number
Shareware Information



Using FractalWeave with Other Programs 
Because FractalWeave can create and read standard Windows bitmap files and transfer 
graphics data via the Windows clipboard, it can easily be used with other Windows 
programs. The examples below illustrate some of the possibilities; no doubt you will 
discover others.
Example 1
Using a Fractal Ball as Wallpaper
1. At the FractalWeave screen, press <Enter> to bring up the New Ball Dialog Box. Press 
<Enter> again to generate a random fractal ball. Select File | Save Ball, and save the file 
to your Windows directory with a BMP extension.
2. Switch to the Windows Control Panel, select Desktop, and, in the Wallpaper section of 
the dialog box, enter the name of the file you just saved. Select the Tile option, then 
close the dialog box. Your Windows desktop will be tiled with the fractal ball you just 
created.
Example 2
Using FractalWeave Images as Wallpaper
1. At the FractalWeave screen, press <Enter> to bring up the New Ball Dialog Box. Press 
<Enter> again to generate a random fractal ball. Select Options | Full Screen to enter full
screen mode. Let the ball run for a bit, then choose File | Save Image and save the image
to your Windows directory with a BMP extension.
2. Switch to the Windows Control Panel, select Desktop, and, in the Wallpaper section, 
enter the name of the file you just saved. Select the Center option, then close the dialog 
box. The Windows desktop will display the image you just created.
Example 3
Creating a "Fractal Ball" with Windows Paintbrush
Select File | Open Ball, and load the file BACKSOON.WWV. This image was generated in 
Windows Paintbrush, copied to the Windows clipboard, then pasted into FractalWeave 
using FractalWeave's Edit | Paste command. The speed was adjusted using the Options | 
Ball Speed command, and the image was then saved using the File | Save Ball command 
with a *.WWV extension.
Example 4
Modifying a "Fractal Ball" with Windows Paintbrush
1. Select File | Open Ball, and load the file BACKSOON.WWV.
2. Use the Edit | Copy command to copy the image to the clipboard.
3. Switch to Paintbrush, and select its Edit | Paste command to copy the image from the 
clipboard. Edit image as you wish, then use the Scissors tool to select the image, and the
Edit | Copy command to copy the modified image back to the clipboard.
4. Switch back to FractalWeave, and choose Edit | Paste to copy the modified image from 
the clipboard into FractalWeave. Your modified image will be displayed.
Note
You can also transfer data between FractalWeave and other programs by creating BMP 
files in one program and reading them in that format into the other.



Example 5
Adding Color Cycling to Images
This example requires a video system capable of color cycling. See Hardware Notes for 
more information.
1. Select File | View Image, and load the file FRACT001.BMP. (This image was generated 
using the Fractint program, available on CompuServe.) Choose Options | Full Screen if 
you want to see the entire image. Choose Options | Color Interval, check the Fast Cycle 
box, and adjust the slider bar so it displays a value of 1. Select OK to close the dialog 
box. The image will redraw and begin to rapidly cycle its colors.
2. Choose File | Save Image and save the file as FRACT002.BMP. Choose File | View Image
to reload it. This time, the image will begin animating automatically. This feature is used 
by the FractalSave Screen Saver program to add color cycling to a screen saver image.



Hardware Notes 
Video system
FractalWeave should run on any video system which Windows supports. For best results, 
however, a monitor capable of displaying at least 256 simultaneous colors at normal VGA
resolution is recommended.
If such a monitor is not detected, the Options | Color Interval command is disabled, and 
FractalWeave's color cycling feature is not available.
Memory
You may receive a "Couldn't allocate memory!" message when trying to display large 
bitmap files with the File | View Image command, or when trying to create a very large 
fractal ball with the File | New Ball command.    Should this occur, close some other 
applications, if possible, and try again.
Running FractalWeave with Other Graphics Programs
When FractalWeave is run with other programs that use the system palette extensively, 
the programs essentially compete for access to the colors available on the system.    
Windows referees the conflict by giving priority to the uppermost window: the top 
window will always get the colors it requests, but windows behind it may suffer some 
color degradation or even "black out". Bringing them to the foreground will restore their 
colors.
Running Multiple Instances of FractalWeave
If you run multiple instances of FractalWeave simultaneously, the programs will function 
normally with one exception: the uppermost instance of the program controls color 
cycling for all of them. This is due to the competition for available colors described 
above.



New Ball Dialog Box 
Click the area of the dialog box you want help on. (Or highlight the area with the <Tab> 
key and press <Enter>.)
Note
When first opened, the actual dialog box displays the values currently in use.



Creating a Fractal Ball 
A fractal ball can be generated by FractalWeave, or imported from another program.
FractalWeave Images
To have FractalWeave generate a ball, select the File | New Ball command or press 
<Enter> to open New Ball Dialog Box.
Other Images
You can use any Windows graphics image in place of a ball generated by FractalWeave. 
Images can be imported from the Windows clipboard with the Edit | Paste command or 
read in from a bitmap (*.BMP) file with the File | Open Ball command. When images are 
imported using either of these methods, the Trails option is set to None, the initial 
position is set to the upper left corner, and the vertical and horizontal step sizes are set 
to 1. These settings can be changed by bringing up the Trails menu, and in the New Ball 
Dialog Box, respectively.
See Also
Using FractalWeave with Other Programs
Hardware Notes



Keyboard/Mouse Commands 
FractalWeave recognizes the following keystrokes in addition to those that Windows 
normally uses:

Alt Highlights menu bar or brings up the popup menu (full-screen 
mode).

Alt+X Exits the program.
Ctrl+Ins Copies the fractal ball to the clipboard.
Shift+Ins Pastes a fractal ball from the clipboard.
Enter Brings up the New Ball dialog box.
Spacebar Stops/starts the fractal ball.
A Speeds up the fractal ball (Accelerate).
D Slows down the fractal ball (Decelerate).
F Forces a palette change (Force).
N Toggles sound off and on (Noise).
P Saves the current screen to a file. (Picture).
S Suspends/resumes color changes (Suspend).
W Toggles between window and full screen display (Window).

The following mouse commands are also used:
Double-click Brings up the New Ball dialog box.
Right-click Invokes the pop-up menu (full-screen mode).
<Ctrl> + left-click Restarts the fractal ball at the mouse cursor.



File Menu 
The File menu contains commands for creating new files, opening existing files, saving 
files, and exiting the program. Select a topic from the list below for more information 
about specific commands.
New Ball
Open Ball
Save Ball
View Image
Save Image
Exit



File | New Ball 
The New Ball command brings up the New Ball Dialog Box which allows you to create a 
new fractal ball. You can manually adjust the ball's size, initial position, vertical and 
horizontal step size, and number of points, or have the program generate the settings at 
random.



File | Open Ball 
The Open Ball command is used to load an existing parameter file or bitmap file into 
FractalWeave. The command opens a dialog box in which you can specify a directory and
file name to be loaded. Parameter files must have been previously created with the Save 
Ball command; bitmap files may have been created by any of the many programs (such 
as Windows Paintbrush) that use the Windows bitmap format.
Since bitmap files don't contain any FractalWeave-specific information, they are loaded 
into the existing window with speed and color interval set to zero and with sound turned 
off. If you modify these values and wish to save them for later use, use the File | Save 
Ball command and specify a WWV file extension.
See Also
Creating a Fractal Ball
Using FractalWeave with Other Programs



File | Save Ball 
The Save Ball command is used to save the current fractal ball to a disk file. The 
command opens a dialog box in which you specify a file name and directory for the file.
If you specify a WWV file extension, a FractalWeave parameter file will be created. If you 
specify a BMP or other extension, FractalWeave will create a standard Windows bitmap 
file.
See Also
Creating a Fractal Ball
Using FractalWeave with Other Programs



File | View Image 
The View Image command displays a Windows bitmap file. The file may be one created 
by FractalWeave or by another program. The command opens a dialog box in which you 
specify the file name and directory of the image file you wish to view.
See Also
Using FractalWeave with Other Programs



File | Save Image 
The Save Image command writes the current screen image to a disk file in Windows 
bitmap format. You can view this image later in FractalWeave or any other program that 
supports the Windows bitmap format. The command opens a dialog box in which you 
specify the file name and directory for the image file.
See Also
Using FractalWeave with Other Programs



File | Exit 
The Exit command closes the FractalWeave window and ends the program.



Edit Menu 
The Edit menu provides commands which allow you to transfer data between 
FractalWeave and other programs via the Windows clipboard. Select a topic from the list 
below for more information about specific commands.
Copy
Paste



Edit | Copy 
The Copy command places a copy of the current fractal ball in the Windows clipboard. 
This allows you to transfer the fractal ball image into other Windows programs (such as 
the Windows Paintbrush program) which can paste graphics images from the clipboard.
See Also
Using FractalWeave with Other Programs



Edit | Paste 
The Paste command copies a graphics image from the Windows clipboard and uses it in 
place of a fractal ball to generate the screen display. This command is unavailable if the 
clipboard is empty or doesn't contain an image in one of the standard Windows bitmap 
formats that FractalWeave recognizes.
See Also
Using FractalWeave with Other Programs



Options Menu 
The Options menu contains commands allowing you to control how the current image is 
displayed. Select a topic from the list below for more information about specific 
commands.
Ball Speed
Color Interval
Trails
Sound
Full Screen



Options | Ball Speed 
The Ball Speed command allows you to adjust the speed of the fractal ball from a 
complete stop to as fast as your system will support. A number of factors influence the 
ball speed, including the horizontal and vertical step size, the size of ball, the speed of 
your computer, and the number of windows currently open.
Speed
Move the scroll bar slider to the left to decrease the image speed, or to the right to 
increase it. Moving the slider all the way to the left will bring the ball to a complete stop; 
moving it all the way to the right moves it as fast as your system can support.
In addition, the ball's speed can be adjusted directly from the keyboard. Pressing 'a' 
increases the ball's speed, pressing 'd' decreases it. Pressing the key repeatedly will 
bring the ball to a full stop, or increase its speed to the maximum supported by your 
system.
Pressing <Spacebar> will alternately start and stop the ball without changing the speed 
setting.
See Also
Keyboard/Mouse Commands



Options | Color Interval 
The Color Interval command allows you to adjust how frequently colors are updated on 
the screen. This command will be unavailable if your video system does not support a 
palette of at least 256 colors.
Interval
Move the scroll bar slider to the left to decrease the color interval, or to the right to 
increase it. Moving the slider all the way to the left disables color changes completely.
Fast Cycle
If the Fast Cycle box is checked, the number under the scroll bar indicates the color 
interval in .025 second increments. If the Fast Cycle box is not checked, the number 
indicates the color interval in seconds.
Colors can also be modified directly from the keyboard. Pressing 's' alternately suspends 
and restores color changes; pressing 'f' forces an immediate color change.
See Also
Hardware Notes
Keyboard/Mouse Commands



Options | Trails 
The Trails sub-menu setting controls how the fractal ball is drawn on the screen. A check 
mark indicates the current setting.
As the fractal ball passes over a section of the screen, the color of each pixel in the 
fractal ball is combined the that of the underlying screen pixel to determine a new color 
value. The Trails setting specifies how the color combination is performed.
None
No trail is generated. To insure a smooth animation, the vertical and horizontal step sizes
are set to 1. You may modify this setting in the New Ball Dialog Box. Small step sizes are 
recommended for best results.
Invert
This is the default setting. New colors are generated when the ball trails overlap, and the 
underlying (blank) screen is always eventually restored.
Copy
Each pixel in the ball is simply copied to the screen without change.
Erase
This setting inverts the image (including the normally black background) before copying 
it to screen.



Options | Sound 
The Sound command turns sound effects off and on. When sound effects are enabled, a 
check mark appears next to the menu item, and a random tone is generated each time 
the fractal ball rebounds from an edge of the program's window. If sound effects are 
enabled, selecting this command again turns the sound off.
Sound effects may be enabled and disabled from the keyboard by pressing the letter 'n'.
See Also
Keyboard/Mouse Commands



Options | Full Screen 
The Full Screen command switches between an ordinary window (including a title bar, 
menu bar, and frame) and one which fills the entire screen. A check mark is placed next 
to the menu item when the program is in full-screen mode. Selecting the menu item 
again restores the window to its previous state.
You can also execute this command directly from the keyboard by pressing the letter 'w'.
Important
Press the right mouse button or the Alt key to bring up the menu in full-screen mode.
See Also
Keyboard/Mouse Commands



Help Menu 
The Help menu contains commands for accessing FractalWeave's on-line help system. 
Select a topic from the list below for more information about specific commands.
Contents
Search for Help On
Keyboard/Mouse
How to Use Help
About FractalWeave



Help | Contents 
The Contents command brings up an overview of FractalWeave's on-line help, much like 
the table of contents in a book. The Contents section is a good place to start for an 
overview, or when you have a general question about the program.
See Also
Contents for FractalWeave Help



Help | Search for Help On 
The Search for Help On command opens an index to FractalWeave's on-line help, much 
like the index of a book. It is most useful when you want help with a specific menu item 
or task.



Help | Keyboard/Mouse 
The Keyboard/Mouse selection displays a table of keyboard and mouse commands 
recognized by FractalWeave. These commands provide short-cuts for common tasks 
which can be used instead of the program's menus.
See Also
Keyboard/Mouse Commands



Help | How to Use Help 
The How to Use Help command displays information on how to use FractalWeave's (or 
any other Windows program's) on-line help system. 



Help | About FractalWeave 
This command opens a dialog box which displays version, copyright and license 
information for the FractalWeave program.



Help | Register 
The Register command opens a dialog box where you can enter your registration name 
and number. Once your registration information has been entered, this command no 
longer appears on the menu.
Entering Your Registration Information
When I receive your registration fee, I will return a registration number which you can 
enter to personalize your copy of FractalWeave. When you receive it, do the following:
1. Select the Register command from the Help Menu.
2. Enter your registration name and number exactly as shown on your registration card.
3.    Select OK.
The Register command will no longer appear on the Help menu, your registration name 
will be displayed in the About FractalWeave box, and the Shareware Reminder screen will
no longer pop up occasionally when you exit the program.
See Also
Registering FractalWeave
Shareware Information



fractal ball
A fractal ball is the basic building block used by FractalWeave to generate its images. 
Usually this is generated by the program, but any Windows bitmap can be used.



pixel
A pixel is the smallest section of a computer screen that can be individually controlled. In 
standard VGA mode, a computer screen is divided into 640 pixels horizontally, and 480 
pixels vertically. 



parameter file
A parameter file contains all the information necessary to recreate a FractalWeave window, 
including the ball settings, speed, sound and color settings, and window size and position. A 
parameter file has a default WWV extension.



bitmap
A bitmap is a way of storing and manipulating graphics (visual) images. Bitmaps can be 
stored in memory (as when they are copied to the Windows clipboard) or in disk file. Such 
disk files normally have a BMP extension.



palette
A palette is the set of colors currently in use by a program. For most video systems, the 
palette is a limited set of colors chosen from a much larger pool (for example, 256 colors 
drawn from an available 65,536).



shareware
Software which is distributed on a "try before you buy" basis.



dimension
A measure of how something fills space. A point has 0 dimension, a line has 1 dimension, a 
square has 2 dimensions, and so on. Surprisingly, many natural objects (such as coastlines 
and clouds) have a dimension which is not a whole number.



screen saver
A program which protects your video monitor from the damage which can result from 
displaying the same image for too long (burn-in). Screen savers monitor the keyboard and 
mouse, and, after a preset period of inactivity, either blank the video screen or vary its 
display until the mouse or keyboard is used again.



color cycling (color animation)
Color cycling rapidly changes the screen colors by modifying the video palette . The effect 
can be either stunning or boring in the extreme, depending upon the color content of the 
image. Windows does not support color cycling on video systems which cannot display at 
least 256 colors simultaneously.



Vertical Step
This value controls the number of pixels the ball moves vertically during each step. The 
number may be negative or positive. Smaller step sizes give a more intricate picture, and a 
slower-moving ball. Changing this value does not cause a new ball to be generated.



Horizontal Step
This value controls the number of pixels the ball moves horizontally during each step. The 
number may be negative or positive. Smaller step sizes give a more intricate picture, and a 
slower-moving ball. Changing this value does not cause a new ball to be generated.



Vertical Offset
This value sets the initial vertical position of the ball, in pixels. 0 represents the top edge of 
the window, increasing the value moves the initial position downwards. If you enter a 
number beyond the current window size, the ball will positioned as far toward the edge as 
possible. Changing this value does not cause a new ball to be generated.
Changing the size of the FractalWeave window has approximately the same effect as 
modifying the initial position. Both have a surprisingly large influence on the color and 
pattern of the generated image.



Horizontal Offset
This value sets the initial horizontal position of the ball, in pixels. 0 represents the left edge 
of the window, increasing the value moves the initial position to the right. If you enter a 
number beyond the current window size, the ball will positioned as far toward the edge as 
possible. Changing this value does not cause a new ball to be generated.
Changing the size of the FractalWeave window has approximately the same effect as 
modifying the initial position. Both have a surprisingly large influence on the color and 
pattern of the generated image.



Ball Width
This value controls the width of the ball, in pixels. The number entered must be positive. 
Larger balls move more slowly for a given step size, and take more time to generate. 
Changing this value will cause a new ball to be generated.



Ball Height
This value controls the height of the ball, in pixels. The number entered must be positive. 
Larger balls move more slowly for a given step size, and take more time to generate. 
Changing this value will cause a new ball to be generated.



Points
This value controls the number of points plotted to create the ball. Larger numbers give a 
brighter, more dense image. The number entered should be greater than 0 and less than 
65,536. Multiplying the ball height by the ball width gives a good upper limit on the number 
of points required; a smaller value can give interesting results, however. Changing this value
will cause a new ball to be generated.



Generate Random button
Selecting this button inserts random values into the dialog box fields. This is a good way to 
explore the kinds of images that can be created.



OK button
Selecting this button accepts the values entered and closes the dialog box. 



Cancel button
Selecting this button abandons any changes made and closes the dialog box.



Help button
Selecting the Help button opens this help screen.






